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Camtasia Studio 6 

 โปรแกรม Camtasia Studio เปนโปรแกรมสําหรับผลิตส่ือการเรยีนการสอนท่ีดี และมีประสิทธิภาพ

โปรแกรมหนึง่ ซ่ึงสามารถบันทึกการทํางานตางๆบนหนาจอคอมพิวเตอร และยังสามารถบันทึกคําอธิบายไปพรอม

กับการบันทึกหนาจอ  จากนัน้ยังสามารถปรับแตงแกไขโดยการแทรกเสียงเพลง เสียงการบรรยายเพ่ิมเติม effect 

ตางๆ เพื่อเพ่ิมความนาสนใจใหกับส่ือการเรียนการสอนที่สรางข้ึน 

ข้ันตอนการเขาสูโปรแกรม Camtasia Studio สามารถทําไดดังน้ี 

1. ดับเบิ้ลคลิกที่  บน  Desktop 

2. หรือคลิกปุม Start -> All Programs -> Camtasia Studio6-> Camtasia Studio 

 

3. จะแสดงหนาตาง Welcome - Camtasia Studio เพ่ือตอนรับเขาสูโปรแกรม ประกอบไปดวย 

  

4 
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3.1  Recorder the  Screen สําหรับจับภาพหนาจอ 

3.2  Recorder Voice Narration สําหรับบันทึกเสียง 

3.3  Recorder PowerPoint สําหรับบันทึก PowerPoint 

3.4  Import Media สําหรับนําไฟลวดิีโอ,รูปภาพมาใชงาน 

3.5 Recent Projects แสดงรายชือ่ไฟลลาสุดท่ีเพิ่งใชงาน สามารถคลิก more… เพื่อดรูายช่ือเพ่ิมเติม 

3.6 Tutories Videos วิดโีอแนะนําการใชงานโปรแกรม Camtasia Studio 

4. คลิกปุม Close จะเขาสูโปรแกรม Camtasia  

สวนประกอบโปรแกรม Camtasia 

 

1. เมนูบาร ประกอบดวยเมนูตางที่ใชในการทาํงาน ไดแก เมนู File,Edit,View,Play,Tools,Helps 

1 
2 

3 

6 

5 

4 
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- เมนู File ใชสําหรับ สราง เปด นําเขาไฟล  บันทึก และออกจากโปรแกรม 

- เมนู Edit ใชสําหรับแกไขวิดโีอ 

- เมนู View ใชสําหรับ View งานในรูปแบบตางๆ 

- เมนู Play ใชสําหรับดูงานท่ีไดสรางไว 

- เมนู Tools ประกอบดวย เครือ่งมือตางๆ ทีใ่ชในการสรางงาน 

- เมนู Help ชวยเหลือการใชงานโปรแกรม 

2. ทูลบาร  ประกอบดวย เครื่องมือตางๆ ท่ีใชในการสรางงาน 

3. Task List เปนที่รวบรวมคําส่ังหลักๆในการทํางานกับวดิโีอ ซ่ึงประกอบดวย 

3.1 Record the screen บันทึกหนาจอ 

3.2 Record PowerPoint บันทึกหนาจอ PowerPoint 

3.3 Add ใชสําหรับนําเขาไฟลตางๆ ประกอบดวย 

 

 

 

- Import media…นําเขาไฟลในรูปแบบตางๆ ไดแก ไฟลภาพ,ไฟลวิดโีอ,ไฟลเสียง 

- Title clips…ใชสําหรับสราง Title ใหกับวดิีโอ 

- Voice narration….ใชสําหรับบันทึกเสียง 

- Record camera…ใชสําหรับบันทึกจากกลอง Webcam 
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 3.4  Edit ใชสําหรับแกไขไฟลงาน ประกอบดวย 

 

- Audio enhancements ใชในการปรับแตง แกไข คุณภาพของเสียง 

- Zoom-n-Pan ใชในการการยอ-ขยาย พื้นที ่

- Callouts ใชสําหรับใสคําอธบิายเพ่ิมลงไปในวดีโีอ 

- Transitions ใชสําหรับใส Effect ตางๆ 

- Captions ใชสําหรับการใสขอความ 

- Flash Quiz and Survey ใชสําหรับการสรางคําถาม และแบบสํารวจ 

- Picture-in-Picture (PIP) ใชสําหรับการบันทึกภาพจากกลองเว็บแคม  

3.5 Produce ใชสําหรับจัดเก็บและนําเสนอไฟลงาน ประกอบดวย 

 

- Produce video as ใชสําหรับการเลือกเก็บไฟลงานในรูปแบบตางๆ 

- Create CD menu ใชสําหรับการจัดเก็บในรูปแบบ CD-ROM 
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- Create web menu ใชสําหรับการจัดเก็บในรูปแบบ แสดงงานผานเว็บ 

- Batch production ใชสําหรับการแปลงไฟลวีดโิอหลายๆ ไฟลพรอมกัน 

4. Clip Bin ใชสําหรับแสดงไฟลงานทีน่ําเขา(Import media)มาใชงาน ไดแก ไฟลวิดโีอ, รูปภาพ, เสียง 

  

ไฟลตาง ๆ ท่ีเลือกนําเขา จะเขามาอยูใน Clip Bin   

 

5.  Timeline และ Storyboard เปนสวนท่ีใชแสดงไฟลวิดโีอที่เลือกมาจาก Clip Bin  โดยจะแสดงวิดโีอในแต

ละชวงเวลา ใชสําหรับแกไขงานตางๆ ท้ังไฟลวิดโิอ,ไฟลเสียง และไฟลรูปภาพ  หรอื เพ่ิมสวนประกอบ

ตาง ๆ ลงในไฟลวิดโีอ ภายใน Timeline จะแยกออกเปนแทร็ค ๆ  ในแตละแทร็ค จะแสดงสวนที่เราใสลง

ไป เชน ภาพเคลื่อนไหว,ภาพน่ิง ,เสียง 
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โดยสามารถแสดงผลสลับไปมาไดระหวาง Timeline และ Storyboard โดยคลกิที่ Show Storyboard  จะ

แสดงสวนที่เปน Storyboard   ซ่ึง Storyboard  จะใชสําหรับดภูาพรวมของเน้ือหา 

 

6.  Preview Area พื้นท่ีที่ใชสําหรับแสดงตัวอยางของวิดโีอท่ีสรางข้ึน โดยจะมีแถบเครื่องมือควบคุมในการ

เลนไฟลวิดโีอใหดวย  

  

การใชงาน Preview Area  นั้นสามารถปรบัแตงมุมมองไดหลายแบบตามความเหมาะสม ดังนี ้

1. ปุมยอ/ขยาย ปุมน้ีจะอยูทางดานบนซายมือ สามารถเลอืกใหแสดงผลแบบพอดีกับหนาตาง(Shrink to 
fit) หรือแสดงผล 100% เต็ม 

 

2. ปุมขยายภาพใหเต็มจอ  (Switch to fullscreen mode)ปุมนี้จะอยูทางดานบนขวามือ ใชสําหรับขยาย
ภาพใหเต็มจอ 

3. ปุมแยกหนาตาง  (Detach/Attach the video preview) ปุมนี้จะอยูทางดานบนขวามอืใชสําหรับการ
แยกแสดงตัวอยางวดิีโอแยกออกมาอีกหนาตาง 
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โปรแกรมตางๆใน Camtasia Studio  

ในชุดโปรแกรม Camtasia Studio มีโปรแกรมตางๆใหเลอืกใชงาน  ซ่ึงแตละโปรแกรมจะมีหนาท่ีในการทํางาน

ตางกัน  ดังน้ี 

1. ใชสําหรับสรางงาน แกไข แทรกวดิีโอ ใส effect ตางๆใหกับงานที่สรางข้ึน 

2.  ใชสําหรับสรางเมนูเพื่อท่ีจะเปดวีดโีอท่ีสรางข้ึน 
 

 

3.  ใชสําหรับสําหรับเปดเลนไฟลวีดโีอ 
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4.  ใชสําหรับบันทึกกจิกรรมตางๆท่ีเกดิข้ึนบนหนาจอคอมพิวเตอร 

 

5.  ใชสําหรับสรางเว็บเมน ู
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ข้ันตอนการใชงาน Camtasia Recorder 

 Camtasia Recorder เปนโปรแกรมที่ใชในการบันทึกหนาจอคอมพิวเตอร ซ่ึงจะทําการจับภาพตามการ

เคลื่อนท่ีของเคอรเซอร รวมถึงกิจกรรมตางๆที่เกดิข้ึนบนหนาจอคอมพิวเตอร มีข้ันตอนดังนี ้

1. คลิกปุม Start -> All Programs -> Camtasia Studio6-> Applications-> Camtasia Recorder 

 

2. หรือคลิกปุม Start -> All Programs -> Camtasia Studio6-> Camtasia Studio 

 

3. จะแสดงหนาตาง Welcome - Camtasia Studio จากนัน้คลิกเลือก  Recorder the  Screen 
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4. จะแสดงหนาตาง Camtasia Recorder ประกอบดวยสวนตางๆดังนี ้

 

4.1 เมนูบาร ประกอบดวยเมนูตางๆ ไดแก 

 เมนู Capture ประกอบดวยคําส่ังเกี่ยวกับการจับภาพ ไดแก  

 

 Record ใชสําหรับบันทึก 

 Stop ใชสําหรบัหยุดการบันทึก 

 Delete ใชสําหรับลบภาพทีเ่พิ่งบันทึก 

 Select Area to Record ใชสําหรับเลือกพ้ืนที่ในการบันทกึภาพ 

 Lock to Application ใชสําหรับล็อกหนาจอในการจับภาพ 

 Record Audio ใชสําหรับบันทึกเสียง 

 Record Camera ใชสําหรับการบันทกึจากกลองเว็บแคม 
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 เมนู Effects ประกอบดวยรูปแบบการใส effects ใหกับงานที่สรางข้ึน ไดแก 

 

 Annotation การใสวันที่และเวลา,การใสขอความลงไปในงานท่ีสรางข้ึน 

 

 Sound การกําหนดใหมีหรือไมมีเสียงเม่ือคลิกเมาส  

 

 Cursur การกําหนด effect ให Cursur ในขณะจับภาพ 

 

 Options…การกําหนดคาตางๆ ใหกับ Annotation,Sound,Cursur 
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 เมนู Tools ประกอบดวยโปรแกรมตางๆ เพือ่เรียกใชงาน ,Option สําหรับกําหนด

คุณสมบัติ,Record Toolbars สําหรับกําหนดการแสดง Toolbar ท่ีใชสําหรับการ record 

 

 เมนู Help ชวยเหลือการใชงานโปรแกรม 

4.2 ในกรอบ Select Area ใชสําหรับการกําหนดพื้นทีใ่นการจับภาพแบบ Full Screen(เต็มจอ) หรือ 

Custom(กําหนดขนาดเอง) 

 

4.3 ในกรอบ Setting ใชสําหรับการกําหนดการจับภาพจากกลองเว็บแคม(Camera),การบันทึกเสียง(Audio) 

และแถบกําหนกระดับความดังของเสียง 

 

4.4 ปุม rec คลิกปุมนี้เพ่ือทําการบันทึกหนาจอ 
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การบันทึกแบบเต็มหนาจอ  สามารถทาํไดดังนี ้

1. หลังจากที่เปดโปรแกรม Camtasia Recorder จากนัน้คลกิท่ีปุม  

 

2. จะแสดงกรอบเสนประสีเขียวรอบหนาจอคอมพิวเตอร ในกรณีที่ตองการอัดเสียงบรรยายเขาไปดวย 

สามารถทําไดโดยการเสียบไมโครโฟนลงไปในชองสําหรับเสียบไมโครโฟน 

 

3. จากนั้นคลิกปุม  หรือกด F9 ที่แปนพิมพเพ่ือทําการบนัทึก  

4. จะปรากฎหนาตางนับถอยหลัง 3-2-1 เพื่อเริ่มการบันทกึ 
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5. จากนั้นจะเริ่มบันทึกหนาจอ ใหทําการเปดโปรแกรมที่ตองการสรางส่ือการเรยีนการสอนพรอมกับสามารถ

พูดบรรยายไปพรอมกนัได 

6. ในกรณีท่ีตองการหยดุการบนัทึกช่ัวคราว สามารถทําไดโดยการกด F9  เม่ือตองการบันทึกตอ กด F9 อีก

ครั้ง 

7. เม่ือตองการหยุกการบันทึกใหกด F10  จากนั้นจะแสดงหนาตาง Preview เพื่อแสดงไฟลวิดโีอที่ไดจากการ

บันทึก 

 

8. ในหนาตาง Preview ประกอบดวยสวนตางๆ ดังน้ี 

    สําหรับแสดง เวลาณ.ตําแหนงแสดงผล/เวลาท้ังหมดของวิดโีอ 

   คลิกเพ่ือใหแสดงผลพอดีกบัหนาจอ Preview 

  ปุมควบคุมการแสดงผล ประกอบดวย ปุมไปยังตําแหนงเริ่มตน,ปุมแสดงผล,ปุมไป

ยังตําแหนงสุดทาย 
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   สําหรับบันทึกงาน สามารนํากลับมาแกไขในภายหลัง เม่ือคลิกปุมนีจ้ะเปดหนาตาง Camtasia 

Recorder เพื่อทําการบนัทึก  จากนั้นใหทําตามข้ันตอนดงันี้ 

1. ในชอง File name : ใหต้ังช่ือไฟลตามตองการ 

2. ในชอง Save as type : ใหเลือกรูปแบบไฟลที่ตองการบนัทึก แบบ Camtasia Recording 

Files(*.camrec) สามารถนําไฟลกลับมาแกไขใหมได กับแบบ Video File(*.avi) 

3. คลิกปุม  เพ่ือบันทึกงาน  จากน้ันหนาตางPreview จะปด เม่ือบันทึกเสร็จ  

 

  สําหรับลบงานที่สรางข้ึนในกรณีท่ีไมตองการ เม่ือคลิกปุมน้ีจะแสดงหนาตางแจงวาตองการลบ

ขอมูลที่ไดบันทึกมาหรือไม ถาตองการใหคลิกปุม  

 

  สําหรับแกไขงาน เม่ือคลกิปุมนี้จะทําการบันทึกและเขาสูหนาจอ Camtasia Studio เพื่อทําการ

แกไขไดเลย 

  สําหรับนําไปเผยแพรในรูปแบบอ่ืน เชน AVI ,Flash 
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การบันทึกแบบกําหนดขนาดหนาจอตามตองการ สามารถทําไดดังนี ้

1. หลังจากที่เปดโปรแกรม Camtasia Recorder จากนัน้คลกิท่ีปุม  

 

2. พิมพขนาดในชอง Dimension ตามตองการ 

 

3. หรือจะเลือก โดยคลกิท่ี  จะแสดงขนาดทีโ่ปรแกรมมีไวให จากนั้นเลือกขนาดตามตองการ 

 

4. และยังสามารถกําหนดโดยคลิกที่  จะแสดงเสนสีแดง  
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5. จากนั้นใชเมาสลากขนาดตามตองการ จะไดขอบเขตที่ตองการจับภาพ 

 

6. สามารถปรับขยายขอบเขตท่ีเลือกโดยการลากตามจุดส่ีเหลี่ยมรอบภาพเพื่อยอขยายขนาดตามตองการ  

7. หรือสามารถปรับโดยการคลกิลากตําแหนงตรงกลางภาพ  เพ่ือยายขอบเขตการจับภาพ 

การบันทึกหนาจอ PowerPoint Presentation สามารถเรียกใชงานได 3 วิธกีารดังนี ้

1. เรยีกใชงานจาก Toolbar ในโปรแกรม PowerPoint สามารถทําไดดังน้ี 

1.1 เปดโปรแกรม Microsoft PowerPoint โดยคลิกปุม Start -> All Programs ->Microsoft Office-

>Microsoft PowerPoint 2007 

1.2 จะแสดงหนาตาง Camtasia Studio PowerPoint Add-In จากน้ันคลิดปุม OK 
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1.3 คลิกท่ีเมนู Add-Ins จะปรากฎเครื่องมือ Recording Toolbar 

 

2. เรยีกใชงานจากหนา Welcome ของโปแกรม Camtasia Studio สามารถทําไดดังนี ้

2.1 เปดโปรแกรม Camtasia Studio คลิกปุม Start -> All Programs -> Camtasia Studio6-> Camtasia 

Studio 

 

2.2 คลิกปุม Recorder PowerPoint  จะแสดงหนาตางโปรแกรม Microsoft PowerPoint จากนั้นคลิก

ที่เมนู Add-Ins จะปรากฎเครือ่งมือ Recording Toolbar 
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3. เรยีกใชงานจาก Task List ในโปแกรม Camtasia Studio ในกรณีที่เปดโปรแกรม Camtasia Studio ไว

สามารถเรยีกผานจากหนาน้ีไดเลยโดยไปท่ี Task List -> Record PowerPoint จากนัน้ คลิกท่ีเมนู Add-Ins 

จะปรากฎเครือ่งมือ Recording Toolbar ซ่ึงประกอบดวยสวนตางๆ ดังนี้ 

  

  สําหรับบันทึกภาพ Presentation 

  สําหรับบันทึกเสียง 

  สําหรับบันทึกภาพจากกลองเว็บแคม 

 สําหรับแสดงหนาตางพีวิวระหวางการภาพจากกลองเวบ็แคม 

 สําหรับกําหนดคาในการบนัทึก เม่ือคลกิเลอืกจะแสดงหนาตาง Camtasia Studio Add-Ins 

Option ซ่ึงประกอบดวย 
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1. ในกรอบ Program 

 Start recording paused ใหหยุดรอกอนยังไมบันทึกทันท ี

 Include watermark แสดงพรายน้ําในวิดโีอ 

 Record mouse cursor บันทึกเมาสเคอรเซอรดวย 

 Highlight cursur เนนสีเคอรเซอร 

 Edit in Camtasia Studio when finished แกไขใน Camtasia Studio ทันทีเม่ือบันทึก

เสร็จ 

 At end Camtasia Studio when finished หลังจากจบการพรีเซนตใหทําอะไรตอ โดย

สามารถเลือกได คือ Continue recording(บันทึกตอ),Prompt to continue recording(

พรอมสําหรับการบนัทึกตอรอใหคลกิเพ่ือบันทึก),Stop recording(หยุดการบนัทึก) 

2. ในกรอบ Video and Audio 

 Video Frame rate  กําหนด Frame rate ของวิดโีอ ปุม Advanceed… สําหรับการ

กําหนดคาเพิ่มเติม 

 Capture layered windows  

 Record audio -> Audio source บันทึกเสียงจากไมโครโฟน,Volume ปรบัระดับเสียง 

3. ในกรอบ Picture In Picture 

 Record from camera บันทึกจากกลองเว็บแคม 

4. ในกรอบ Record Hotkey กําหนดคียลดัในการใชงาน 

 Record/Pause บันทึก/หรือหยุดช่ัวคราว 
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 Stop หยุดการบันทึก 

 สําหรับกรณีตองการความชวยเหลือการใชงานโปรแกรม 

 หลังจากเปดเรยีกใชงานดวยวิธกีารตางๆขางตนแลว จากน้ันทําการบันทึกหนาจอโปรแกรม PowerPoint ซ่ึง

มีข้ันตอนดังนี ้

1. เปดไฟลที่ตองการบันทึกหนาจอ 

2. คลิกปุม  เพ่ือทําการบันทึก 

 

3. จะแสดงหนาตาง Camtasia Studio Recording Paused 

4. จากนั้นคลิกปุม  เพื่อทําการบันทึก 

 

5. ในกรณีท่ีตองการหยดุบันทกึช่ัวคราว กด CTRL+Shift+F9 บนแปนพมิพ จะแสดงหนาตาง 
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6. หากตองการบนัทึกตอ คลกิปุม  

7. เม่ือตองการหยุดการบันทึกใหกด CTRL+Shift+F10 หรอืปุม Esc บนแปนพิมพ 

8. จะแสดงหนาตาง ถามวาจะบันทึกตอ(Continue recording) หรือจะหยุด(Stop Recording) ถาตองการหยุด

การบนัทึกคลกิปุม   

 

9. จากนั้นจะแสดงหนาตาง Save Camtasia Recording As… 
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10. ต้ังช่ือไฟลในชอง File name: จากนั้นคลิกปุม   

11. จะแสดงหนาตาง ใหเลือกวา จะบันทกึงานไปใชในรูปแบบใด(Produce your recording) หรือจะแกไขงาน

(Edit your recording) จากน้ันคลิกปุม    

 

12. ในกรณีท่ีเลือก Edit your recording เพ่ือทาํการแกไขงานท่ีไดบันทกึ หลังจาดคลกิปุม  จะแสดง

หนาตาง Camtasia Studio ข้ึนมาใหทําการแกไข 

13. แตถายังไมตองการทําทั้ง 2 อยางในตอนนี ้ใหคลิกปุม  

การใส Effect ใหกับชิ้นงาน 

 การใส Effect เพื่อเพ่ิมความนาสนใจ ซ่ึงสามารถทําไดหลายรูปแบบดังน้ี 

 การใส Title  เปนการแทรกภาพและขอความเพ่ือเปนไตเต้ิลกอนเขาสูเนื้อหาเปนหัวเรื่องบทเรียน หรือในสวน

ตอนทายอาจจะใสช่ือผูจัดทํา มีขั้นตอนดังน้ี 

1. หลังจากเปดโปรแกรม Camtasia Studio คลิกที่เมนู Edit->Title Clips… 
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2. จะแสดงหนาตาง Title Clips…ซ่ึงประกอบดวย 

 

 ในกรอบ Properties ชอง Title name: พิมพช่ือ title 

 ในกรอบ Background ในสวน Image เลือกรูปภาพที่ตองการทํา Background และคลิกเลือก 

Color… เพ่ือเลือกสี Background  

 ในกรอบ Text เลือกรูปแบบฟอนต ขนาด สี จากนั้นพิมพขอความในชองสีเหลี่ยมดานลาง จะเห็น

วาในหนาตางพรวีิวแสดงขอความท่ีพิมพ 
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3. เสร็จแลว คลกิปุม OK จะกลบัมาท่ีหนาตาง Camtasia Studio 

4. Title Clips ท่ีสรางก็จะปรากฎอยูใน Clip Bin 

 

5. จากน้ัน คลิกลาก Title Clip ที่สรางข้ึนมาวางบน Timeline ดานหนาสุด 

 

6. คลิกปุม  เพื่อแสดงผลงาน  จะสังเกตเห็น Title ที่สรางจะแสดงข้ึนมากอน 

4 
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 การใส Callout เปนการใสขอความอธิบายในสวนตางๆ มีข้ันตอนดังน้ี 

1. หลังจากเปดโปรแกรม Camtasia Studio คลิกที่เมนู Edit->Callouts… 

 

2. จะแสดงหนาตาง Callouts Properties  
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3. คลิกตําแหนงบน Timeline ที่ตองการให Callout แสดง 

  

4. คลิกปุม  เพ่ือเพิ่ม Callout ซ่ึงประกอบดวย 

 

 ในกรอบ Shape  

 ชอง Type: คลกิ   เพ่ือเลือกรปูแบบ Callout 
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 ในสวน Rotation: คลิก  เพ่ือเลือกทิศทางการแสดง Callout 

 

 ปุม สําหรับเลอืกสีภายใน Callout 

 ปุม  สําหรับเลอืกสีขอบ Callout 

 ในกรอบ Text เลือกรูปแบบฟอนต ขนาด สี จากนั้นพิมพขอความในชองสีเหลี่ยมดานลาง จะเห็น

วาในหนาตางพรวีิวแสดงขอความท่ีพิมพอยูใน Callout 

 

 ในกรอบ Properties สําหรับกําหนดคาตางๆใหกับ Callout 
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 Fade In: กําหนดเวลาแสดง Callout 

 Fade out: กําหนดให Callout หายไป 

 Add drop Shadow กําหนดเงาให Callout 

 Opacity: กําหนดความทึบสวางให Callout 

 Style: กําหนดรูปแบบมใีหเลอืก 3 รูปแบบ Plain,3D edge,smooth 

 Width: และ Height กําหนดความกวาง ยาว ให Callout 

 X: และ Y: กําหนดตําแหนงตามแกน X,Y 

5. จากน้ันคลิกปุม Finished ใน Timline จะมี Callout ที่สรางข้ึน 
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การใส Transition เปนการใส effect ค่ันระหวางแตละหนาใหกับงานที่สรางข้ึน มีข้ันตอนดังนี ้

1. หลังจากเปดโปรแกรม Camtasia Studio คลิกที่เมนู View->Storyboard  

 

2. หรือคลิก Show Storyboard ที่ Timeline 

 

 

 

3. ในกรอบ edit เลือก Transition 
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4. จะแสดงหนาตาง Transitions 

 

5. ดับเบิ้ลคลิกเลอืกรูปแบบ Transitions ที่ตองการ 

6. ในหนาพรีวิวจะแสดงการทาํงานของ Transitions ที่เลือก 

7. จากนั้นเลือก Transitions ที่ตองการโดยการลากไปวางระหวางแตละหนาใน Storyboard 
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8. ในกรณีท่ีตองการแกไข effect ทําไดโดยการคลกิขวาที่ Transitions 

 

8.1 คลิก Change Transition ในกรณีที่ตองการเลือก Transition แบบอ่ืน 

8.2 คลิก Transition duration… เพื่อกําหนดเวลาในการแสดง effect 

 

8.3 คลิก Remove From Storyboard เพื่อลบ Storyboard 
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การนําเสนอผลงาน 

หลังจากที่สรางงานเสร็จเรยีบรอยแลว การเผยแพร(Produce Video) เปนข้ันตอนสุดทายที่ตองทําเพื่อ

นําเสนอผลงาน สามารถสรางงานออกมาไดหลายรูปแบบดังนี ้

 การนําเสนอผลงานในรปูแบบไฟลวิดีโอ นามสกุล .avi มีขั้นตอนดังน้ี 

1. เปดไฟลงานทีต่องการนําเสนอ 

2. ท่ีเมนูบารเลือก File->Produce Video As… 

 

3. จะแสดงหนาตาง Production Wizard 

4. คลิก  เลือก Custom production settings 

5. จากนั้นคลิกปุม   
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6. จะแสดงหนาตางใหเลือกรปูแบบในการนําเสนอผลงาน 
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7. คลิกเลือกรูปแบบ   

8. จากนั้นคลิกปุม  

9. จะแสดงหนาตาง AVI Encoding Options 

 ในกรอบ Video 

 Colors: สําหรับกําหนดสีใหวิดโีอ 

 Frame rate: สําหรับกําหนด Frame rate 

 ในกรอบ Audio คลิกเลือก Encode audio 

 

10. จากนั้นคลิกปุม  
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11. จะแสดงหนาตาง Video Size กําหนดขนาดวิดโีอ และคลิกในสวน  เพือ่กําหนดสี 

Background 

 

12. จากนั้นคลิกปุม  

13. จะแสดงหนาตาง Video Options กําหนดรายละเอียดตางๆเกีย่วกับวดิโีอ  
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14. จากนั้นคลิกปุม  

15. จะแสดงหนาตาง Marker option สําหรับกําหนดเลือกสารบัญ 

16. จากนั้นคลิกปุม  

 

17. จะแสดงหนาตาง Produce Video ต้ังช่ือไฟลและเลือก Folder ที่เก็บ 
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18. จากนั้นคลิกปุม  

19. โปรแกรมจะทําการเรนเดอร 

 

20. จากนั้นจะแสดงหนาตาง Production is complete 

 

21. คลิกปุม  เปนอันส้ินสุดข้ันตอนการนําเสนอผลงาน 
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 การนําเสนอผลงานในรปูแบบไฟล Flash มีข้ันตอนดังน้ี 

1. ทําตามข้ันตอนขอ 1-5 ของหัวขอการนําเสนอผลงานในรูปแบบไฟลวิดโีอ นามสกุล .avi 

 

2. คลิกเลือกรูปแบบ   

3. จะแสดงหนาตาง  Flash Templates 
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4. คลิก  เลือก Template ท่ีตองการ 

 

5. คลิกปุม  เพื่อทดสอบแสดงงาน 

6. คลิกเลือก Preiew Current Settings 

 

7. โปรแกรมจะทําการเรนเดอร 
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8. จากนั้นจะแสดงหนาตางบราวเซอร แสดงวิดโีอ 

 

9. ปดหนาตางบราวเซอรแสดงงาน  

10. จากนั้นกลับมาคลิกปุม  

11. จะแสดงหนาตาง Video Options กําหนดรายละเอียดตางๆเกีย่วกับวดิโีอ  

 

12. จากนั้นกลับมาคลิกปุม  
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13. จะแสดงหนาตาง Produce Video ต้ังช่ือไฟลและเลือก Folder ที่เก็บ 

 

14. จากนั้นคลิกปุม  

15. โปรแกรมจะทําการเรนเดอร 
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16. จากนั้นจะแสดงหนาตาง Production is complete 

 

17. คลิกปุม  เปนอันส้ินสุดข้ันตอนการนําเสนอผลงาน  
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 การนําเสนอผลงานในรปูแบบ .exe สามารถใชงานไดทันที โดยไมตองติดต้ังโปแกรมเพิ่มเติม มีข้ันตอน

ดังน้ี 

1. เปดโปรแกรม Camtasia Studio 

2. ท่ีเมนูบารเลือก File->Pack and Show… 

 

3. จะแสดงหนาตาง Pack and Show 
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4. ในกรอบ Video file name คลิกปุม  เพื่อเลอืกไฟลที่ตองการนําเสนอ จะแสดงหนาตาง Select Video 

File คลิกเลือกไฟลวิดโีอ จากน้ันคลิกปุม   

 

5. ในกรอบ Executetable file name จะแสดงช่ือไฟลที่เก็บผลงาน 

 

6. จากนั้นคลิกปุม   

7. จะแสดงหนาตาง ใหกําหนดรูปแบบการแสดงวดิีโอ 
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8. จากนั้นคลิกปุม   

9. จะแสดงหนาตาง The video is ready to be packaged  

 

10. คลิกปุม  จะไดไฟล .exe 

11. ดับเบิ้ลคลิกไฟล .exe จะสามารถเปดไฟลไดทันทโีดยไมตองติดต้ังโปรแกรมเพ่ิม 

 

 




